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What is the NAACCR Record Layout?What is the NAACCR Record Layout?

�� File format used to exchange (most) cancer File format used to exchange (most) cancer 

registry data in the U.S. and Canadaregistry data in the U.S. and Canada

–– Most path lab data being exchanged in HL7 Most path lab data being exchanged in HL7 

and pipeand pipe--delimited formatsdelimited formats
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and pipeand pipe--delimited formatsdelimited formats

�� “Flat” text file, one patient record per line“Flat” text file, one patient record per line

�� FixedFixed--field width (fields are not delimited)field width (fields are not delimited)

�� Managed by NAACCR’s IT & Uniform Managed by NAACCR’s IT & Uniform 

Data Standards (UDS) CommitteesData Standards (UDS) Committees



What’s New With v12?What’s New With v12?

�� All date fields changedAll date fields changed

–– Now in YYYYMMDD formatNow in YYYYMMDD format

–– Only valid years (no 9s, 8s, or 0s)Only valid years (no 9s, 8s, or 0s)

–– Blanks indicate unknown day, month, yearBlanks indicate unknown day, month, year
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–– Blanks indicate unknown day, month, yearBlanks indicate unknown day, month, year

–– New date flags indicate why date is blankNew date flags indicate why date is blank

–– Only affects how dates are Only affects how dates are exchangedexchanged as part of as part of 

Record Layout, not how Record Layout, not how storedstored in the registry in the registry 

databasedatabase



What’s New With v12?What’s New With v12?

�� 126 new data items (incl. 26 date flags)126 new data items (incl. 26 date flags)

�� 14 newly retired data items14 newly retired data items

�� Total of 489 active data items, & 15 “reserved”Total of 489 active data items, & 15 “reserved”
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�� Most text fields expanded Most text fields expanded –– 16 fields now have 16 fields now have 

1000 characters (mostly Dx & Tx text)1000 characters (mostly Dx & Tx text)

�� As a result of these changes, no. of characters As a result of these changes, no. of characters 

per line more than tripled to 22,824 !!!per line more than tripled to 22,824 !!!



Challenges encountered during implementationChallenges encountered during implementation
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Remember…Remember…

Conference theme is “Keeping pace w/…technology”Conference theme is “Keeping pace w/…technology”



New Date FormatNew Date Format

�� All computer operations involving dates All computer operations involving dates 

(calculations, queries, etc.) using the (calculations, queries, etc.) using the 

NAACCR record layout had to be reviewed NAACCR record layout had to be reviewed 

and most were revisedand most were revised

Alaska Cancer Registry

and most were revisedand most were revised

–– Old operations expecting MMDDYYYY, Old operations expecting MMDDYYYY, 

not YYYYMMDDnot YYYYMMDD

–– Year queries had to be changed from Year queries had to be changed from 

Right(…,4) to Left(…,4).Right(…,4) to Left(…,4).



Longer Line LengthLonger Line Length

�� Many text editors cannot edit and save 22,824 Many text editors cannot edit and save 22,824 

characters per linecharacters per line

�� Popular editors that can’t properly edit v12 files:Popular editors that can’t properly edit v12 files:

–– Programmer’s File Editor Programmer’s File Editor (freeware) truncates each (freeware) truncates each 
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–– Programmer’s File Editor Programmer’s File Editor (freeware) truncates each (freeware) truncates each 

line at 16,385 charactersline at 16,385 characters

–– UltraEditUltraEdit ($60) wraps line at 4096 characters ($60) wraps line at 4096 characters ----

each line is displayed as six separate lines, so each line is displayed as six separate lines, so 

editing is difficultediting is difficult



Text Editors for v12 FilesText Editors for v12 Files

�� Notepad++Notepad++

–– Download from Download from 
http://notepadhttp://notepad--plus.sourceforge.net/uk/site.htmplus.sourceforge.net/uk/site.htm

–– FreewareFreeware
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–– FreewareFreeware

�� TextPadTextPad

–– Download from http://www.textpad.comDownload from http://www.textpad.com

–– Available for purchase for about $25Available for purchase for about $25

–– Free trial version available for downloadFree trial version available for download



Importing a v12 File into MS AccessImporting a v12 File into MS Access

�� File>Get External Data>Import>Text FilesFile>Get External Data>Import>Text Files

�� Click on “Advanced” command buttonClick on “Advanced” command button

�� Click on “Specs” command buttonClick on “Specs” command button
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�� Choose the NAACCR v12 import Choose the NAACCR v12 import 

specificationspecification
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What,What, you don’t have NAACCR v12 import specs?you don’t have NAACCR v12 import specs?
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What,What, you don’t have NAACCR v12 import specs?you don’t have NAACCR v12 import specs?

DON’T

PANIC!



Creating v12 Import SpecsCreating v12 Import Specs

�� 489 data items, but 255 columns max, so need to 489 data items, but 255 columns max, so need to 

combine data itemscombine data items

�� Refer to NAACCR Standards Vol 2, Refer to NAACCR Standards Vol 2, 

Data Dictionary, Ch 7: Record Layout TableData Dictionary, Ch 7: Record Layout Table

Alaska Cancer Registry

Data Dictionary, Ch 7: Record Layout TableData Dictionary, Ch 7: Record Layout Table

�� Start entering information into the fixed width Start entering information into the fixed width 

Specs tableSpecs table

�� Make large text fields (>255 char) into memo fieldsMake large text fields (>255 char) into memo fields

�� And after several hours…And after several hours…
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OR… Just call me and I’ll send you my import specs!OR… Just call me and I’ll send you my import specs!
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OR… Just call me and I’ll send you my import specs!OR… Just call me and I’ll send you my import specs!



Software Upgrades: Software Upgrades: 

Central Registry DatabaseCentral Registry Database

�� Vendor:Vendor:

–– Added the new data items to the data Added the new data items to the data 

dictionarydictionary

–– Added new import/export file specification Added new import/export file specification 
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–– Added new import/export file specification Added new import/export file specification 

for Type A (abstract), C (confidential), and I for Type A (abstract), C (confidential), and I 

(incident) files(incident) files

–– Upgraded Edits Metafile and CSUpgraded Edits Metafile and CS

–– Converted codes in existing database recordsConverted codes in existing database records



Software Upgrades: Software Upgrades: 

Central Registry DatabaseCentral Registry Database

�� User:User:

–– Added 126 new data items to data entry grid in Added 126 new data items to data entry grid in 

logical placeslogical places

–– Removed 14 retired data items from data entry gridRemoved 14 retired data items from data entry grid
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–– Removed 14 retired data items from data entry gridRemoved 14 retired data items from data entry grid

–– Added stateAdded state--specific fields to new v12 file specsspecific fields to new v12 file specs

–– Created descriptive name for each new data item; Created descriptive name for each new data item; 

assigned assigned default values if appropriate default values if appropriate 

–– In Web Plus, developed “help prompts” for each In Web Plus, developed “help prompts” for each 

new data itemnew data item



Software Upgrades: Software Upgrades: 

Central Registry DatabaseCentral Registry Database

�� User:User:

–– VeryVery time consuming process!time consuming process!

–– Central level software:  Most programs have at Central level software:  Most programs have at 

least 3 display types (source record, consolidated least 3 display types (source record, consolidated 
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least 3 display types (source record, consolidated least 3 display types (source record, consolidated 

tumor, consolidated demographics) tumor, consolidated demographics) 

–– Hospital level software:  Programs can have many Hospital level software:  Programs can have many 

display types (AK had 9 in Web Plus!) depending display types (AK had 9 in Web Plus!) depending 

on type and size of the hospital or physician officeon type and size of the hospital or physician office



Software Upgrades: Software Upgrades: 

Central Registry DatabaseCentral Registry Database

�� User:User:

–– For AK, ODBC connection to the data For AK, ODBC connection to the data 

dictionary in SQL Server through MS Access dictionary in SQL Server through MS Access 

greatly greatly reduced reduced time in updating new data items time in updating new data items 
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greatly greatly reduced reduced time in updating new data items time in updating new data items 

by doing a lot of copy & pasteby doing a lot of copy & paste



Software Upgrades: Software Upgrades: 

Central Registry DatabaseCentral Registry Database

�� Vendors QC their software, but users still find Vendors QC their software, but users still find 

bugsbugs

–– Users enter realUsers enter real--world data vs. vendor’s test world data vs. vendor’s test 

datadata
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datadata

»» Example: Path Date Spec CollectionExample: Path Date Spec Collection

»» 1414--digit date, but vendors used to 8digit date, but vendors used to 8--digit datedigit date

»» NAACCR NAACCR VolVol II data II data dictdict had YYYYMMDDhad YYYYMMDD

»» Uploading a 14Uploading a 14--digit date into an 8digit date into an 8--digit date field digit date field 

crashed the program!crashed the program!



Software Upgrades:Software Upgrades:

Central Registry DatabaseCentral Registry Database

�� Vendors QC their software, but users still find Vendors QC their software, but users still find 

bugs!bugs!

–– User’s database slightly different configuration than User’s database slightly different configuration than 

vendor expected due to previously skipped minor vendor expected due to previously skipped minor 
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vendor expected due to previously skipped minor vendor expected due to previously skipped minor 

upgradesupgrades

–– User might use the software differently than was User might use the software differently than was 

done in the vendor’s test environmentdone in the vendor’s test environment

–– A vendor modification inadvertently breaks A vendor modification inadvertently breaks 

something else that was previously working just finesomething else that was previously working just fine



Software Upgrades: Software Upgrades: 

Link PlusLink Plus

�� Link Plus currently cannot process more than 10,000 Link Plus currently cannot process more than 10,000 

characters per line (new Beta version can)characters per line (new Beta version can)

�� Need to be able to export a “Type C” file from your Need to be able to export a “Type C” file from your 

central registry database softwarecentral registry database software
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central registry database softwarecentral registry database software

�� Or… import a “Type A” file into MS Access, delete Or… import a “Type A” file into MS Access, delete 

the the DxDx & & TxTx text fields to make a “Type C” filetext fields to make a “Type C” file

�� Or… create a custom text file with just the fields you Or… create a custom text file with just the fields you 

needneed

�� Or… use the Beta versionOr… use the Beta version



Software Upgrades: Software Upgrades: 

Link PlusLink Plus

�� Common practice to reuse Link Plus configuration Common practice to reuse Link Plus configuration 

filesfiles

�� All reused All reused configconfig files need to have the date files need to have the date 

properties modified from MMDDYYYY to properties modified from MMDDYYYY to 
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properties modified from MMDDYYYY to properties modified from MMDDYYYY to 

YYYYMMDD formatYYYYMMDD format

�� Unknown date elements need to be modified from 9s Unknown date elements need to be modified from 9s 

to blankto blank



Software Upgrades: Software Upgrades: 

eMaRCeMaRC PlusPlus

�� eMaRCeMaRC Plus translates HL7 and pipePlus translates HL7 and pipe--delimited files delimited files 

path files into NAACCR record layoutpath files into NAACCR record layout

�� User needs to add new data items to data entry grid User needs to add new data items to data entry grid 

& modify defaults to v12 standards& modify defaults to v12 standards
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& modify defaults to v12 standards& modify defaults to v12 standards

�� In v11, big problem with not enough characters In v11, big problem with not enough characters 

(about 200) to accommodate the descriptive text in (about 200) to accommodate the descriptive text in 

the path reportsthe path reports

�� In v12, descriptive text fields now 1000 characters, In v12, descriptive text fields now 1000 characters, 

so much better for conversion of path filesso much better for conversion of path files



Software Upgrades: Software Upgrades: 

SEER*PrepSEER*Prep

�� SEER*Prep processes your registry data w/state SEER*Prep processes your registry data w/state 

population data so it can be accessible in SEER*Statpopulation data so it can be accessible in SEER*Stat

�� Newest version has DD file for v12Newest version has DD file for v12

�� Some NAACCR file editing is needed prior to Some NAACCR file editing is needed prior to 

processing:processing:
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processing:processing:

–– Add combined stateAdd combined state--county FIPscounty FIPs

–– Add bladder behavior recode (2Add bladder behavior recode (2---->3)>3)

–– Add stateAdd state--specific fieldsspecific fields

–– Update Date of Last Contact to death clearance date for Update Date of Last Contact to death clearance date for 

survival analysissurvival analysis



Software Upgrades: Software Upgrades: 

SEER*PrepSEER*Prep

�� Run edited file through NAACCR’s NHAPIIA Run edited file through NAACCR’s NHAPIIA 

SAS program to add derived Race/Ethnicity & SAS program to add derived Race/Ethnicity & 

create “Type I” file for import into SEER*Prepcreate “Type I” file for import into SEER*Prep
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Other Upgraded SoftwareOther Upgraded Software

�� Needed to install new versions of:Needed to install new versions of:

–– EditWriterEditWriter

–– GenEDITSGenEDITS

–– InterInter--Record Edits UtilityRecord Edits Utility
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–– InterInter--Record Edits UtilityRecord Edits Utility



Dates and Date FlagsDates and Date Flags

�� All Dates are All Dates are exchangedexchanged in new standard, in new standard, 

but can be but can be storedstored in old standard in registry in old standard in registry 

databasedatabase

�� If date and date flag are not edited together, If date and date flag are not edited together, 
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�� If date and date flag are not edited together, If date and date flag are not edited together, 

then you can get a date that does not agree then you can get a date that does not agree 

with the flagwith the flag

–– Example:  Known date & nonExample:  Known date & non--blank flagblank flag



Dates and Date FlagsDates and Date Flags

�� When there is a known date & nonWhen there is a known date & non--blank blank 

flag, software will blank out the date and flag, software will blank out the date and 

report only the flag in exchange file!report only the flag in exchange file!

�� AK developed a routine that checks AK developed a routine that checks 
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�� AK developed a routine that checks AK developed a routine that checks 

database for inconsistencies between date database for inconsistencies between date 

and flagand flag



What Did We Learn?What Did We Learn?

�� Still a lot of work for the user to upgrade registry Still a lot of work for the user to upgrade registry 

software to v12 standards after vendor’s upgradesoftware to v12 standards after vendor’s upgrade

–– Added new data items to data entry grid, Added new data items to data entry grid, 

added descriptive names, default values, help promptsadded descriptive names, default values, help prompts
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–– Checked for bugs & worked with vendor to correctChecked for bugs & worked with vendor to correct

–– Modified dateModified date--related SQL queries (left side, not right)related SQL queries (left side, not right)

�� Needed new tools to edit v12 filesNeeded new tools to edit v12 files

�� Needed to reinstall new utility programs compatible Needed to reinstall new utility programs compatible 

with v12 files & standardswith v12 files & standards



Thanks very much!Thanks very much!
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